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Release 3.0 Updates  

The Commonwealth of Massachusetts and the Executive Office of Health and Human Services 
(EHHS) have made system enhancements to the Children's Behavioral Health Initiative (CBHI) Child 
and Adolescent Needs and Strengths (CANS) application (Release 3.0), which is now available to all 
users.   

All documentation related to the CBHI CANS application ("Reference Guides" and "Learn How To" 
CBTs) has been updated and are posted on the CBHI website. Visit 
www.mass.gov/eohhs/gov/commissions-and-initiatives/cbhi/, click the Child and Adolescent Needs 
and Strengths (CANS) link, then select the Using the CANS Application on the Virtual Gateway 
link. 

Below is a summary of the Release 3.0 improvements and new features. 

New Consent Process 

The new Consent Process permits a provider to enter the CANS on the Virtual Gateway (VG) account 
and share the CANS with all other providers to whom the caregiver has given consent.  This will allow 
all providers caring for the child to have a clear picture of what is happening in the child and family’s 
life. This is particularly important when a child is cared for by multiple providers or requires treatment 
in different levels of care. 

New Consent Forms 

The new Consent Form explains to the caregiver that by signing the Consent Form, they are giving 
permission to a provider to enter the CANS on the VG and share the CANS with any other providers 
to whom the caregiver has given consent. 

Link to CANS Consent Forms: www.mass.gov/eohhs/gov/commissions-and-initiatives/cbhi/child-and-
adolescent-needs-and-strengths-cans/cans-forms.html). 

To learn more about how the Consent process works in daily practice, please view the  

CANS  Consent Step-by-Step Guide and Flowchart which can be found at 
http://www.mass.gov/eohhs/gov/commissions-and-initiatives/cbhi/child-and-adolescent-needs-and-
strengths-cans/using-the-cans-application-on-the-virtual-gateway.html. 

Consent FAQs 

What do I need to know about the new Consent process? 

The new Consent process permits a provider to enter the CANS on the Virtual Gateway (VG), 
and allows other providers, to whom the caregiver has given consent, to view and copy the CANS. 
This will allow all providers caring for the child to have a clear picture of what is happening in the child 
and families life. This is particularly important when a child is cared for by multiple providers or 
requires treatment in different levels of care.   

What specific information does MassHealth require to be entered into the Virtual Gateway 
(VG), and does this information require client permission? 

Information about member demographics and whether the child/youth meets the criteria for Serious 
Emotional Disturbance (SED) collected with CANS must be entered into the VG, and does not require 
client permission.  

What information requires member permission to be entered into CANS application on the VG 
and what is the process of documenting consent in the application? 

Member permission is granted by a caregiver or an emancipated youth under age 21, and is required 
to enter CANS ratings and narrative fields in the VG. The application includes features for 
documenting consent, as well as, features for the member to cancel consent. MassHealth requires 

http://www.mass.gov/eohhs/gov/commissions-and-initiatives/cbhi/
http://www.mass.gov/eohhs/gov/commissions-and-initiatives/cbhi/child-and-adolescent-needs-and-strengths-cans/cans-forms.html
http://www.mass.gov/eohhs/gov/commissions-and-initiatives/cbhi/child-and-adolescent-needs-and-strengths-cans/cans-forms.html
http://www.mass.gov/eohhs/gov/commissions-and-initiatives/cbhi/child-and-adolescent-needs-and-strengths-cans/using-the-cans-application-on-the-virtual-gateway.html
http://www.mass.gov/eohhs/gov/commissions-and-initiatives/cbhi/child-and-adolescent-needs-and-strengths-cans/using-the-cans-application-on-the-virtual-gateway.html
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provider organizations use the consent form created by EOHHS.  

What is different about the new consent process? 

The new Consent form, which is scheduled to go-live in February 2015, features more user-friendly 
language that makes it easier for both the provider and caregiver to understand the consent process, 
and explains how the information gathered is stored in a safe place.  

The new consent process allows providers who have received consent, to view and copy CANS 
records entered by other providers on the VG.  This permits all providers with active consent, who are 
caring for the same child to have a clear and timely picture of what is happening in the child and 
family’s life. This is particularly important when a child is cared for by multiple providers or requires 
treatment in different levels of care.  For families, it means not having to repeat their stories. For new 
providers, it means that they will have immediate access to current information that affects their child’s 
care and will be able to view, copy and edit a CANS previously created by another provider. Copying 
and editing existing CANS will also save time and effort for providers. 

What does the new language does the Consent form contain? 

The new Consent form explains to the caregivers that signing the consent form gives permission to a 
provider to: 

1.) Enter the CANS on the VG  

2.) Such that any other providers, to whom the caregiver has given consent, will be able to view and 
copy the CANS record. 

Please click to Read the new Consent form.  

How will this work?  

After the go-live date, all prior consent will no longer be valid as the Consent status in the CANS 
Application on the Virtual Gateway (VG) will be re-set to “no” for all members. You will be 
required to: 

 Obtain new Consent from the caregiver when you next see them and then, you will need to 
enter “yes” in the ‘Manage Consent” tab on the CANS application on the VG. 

 If the caregiver declines consent then, you will simply enter “no” in the Manage Consent tab. 
You are still required to enter the SED section on the CANS application on the VG but 
complete the CANS on paper and enter into the child’s medical record. 

How will I know if another provider has completed a CANS on the same child? 

When a new provider, with consent, enters a child’s CANS onto the CANS application on the VG for 
the first time, the new provider will automatically be able to see the child’s previous CANS from other 
providers.  

The new provider will have the option to copy a previous CANS. The copy is now the new provider's 
CANS and can be edited as necessary, including the addition of Summary Comments at the end of 
each domain.  

When a new provider copies a CANS, they are not altering in any way the previous CANS completed 
by another provider.  

What do I need to tell members about the new consent process? 

CBHI strongly encourage you to discuss the new consent form with caregivers prior to the go-live date 
so that you have signed consent forms on hand when the new process is active. On the go-live date, 
all existing consents, regardless of their stated end dates, will expire.  We recommend that you throw 
away all blank copies of the old Consent form that you or a DEO in your organization may have on 
hand. 

http://www.mass.gov/eohhs/docs/masshealth/cbhi/consent-form-eng.pdf
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Will the faxing process change? 

No. Current procedures for faxing in your signed consent forms will remain unchanged. Remember to 
generate a Fax Information Sheet (cover sheet) from the CANS application, just as you do now. (If the 
caregiver declines consent, the process remains the same. You should document this fact in the 
chart, but do not fax anything to MassHealth.) 

Will there be “how to” support in the CANS Consent Resources and Guides?                                                                                                                     

We will revise all of the related information in the “How to use the CANS Application on the Virtual 
Gateway” page (http://www.mass.gov/masshealth/cans) in the CANS section of the CBHI website to 
offer updated information. Also, CBHI will offer a webinar on the new consent process prior to the start 
date for the new process. 

The Consent Webinar will be posted on the CBHI website. Providers may also call the VG Customer  
Service Helpdesk at 800-421-0938 or (TTY) 617-847-6578 for those with partial or total hearing loss) 
and ask for help with the new consent process. The call will be transferred to CBHI for assistance.  

The revised CANS Consent Reference Guide, also found on this page,  will instruct users on how to 
manage consent, download the consent form, as well as how to fax the consent form. The Guide will 
also offer assistance on how to talk to families about the new Consent process.   

What should I do with the signed consent form after I document consent in the       
application? 

The 4-page signed consent form, combined with the Consent Information Sheet (fax cover sheet), 
must be faxed to MassHealth at 617-887-8708. The Consent Information Sheet (fax cover sheet) can 
be printed from the CANS application in VG, which will automatically print both member and provider 
information on the CANS Information Sheet (fax cover sheet). Do not use your organization’s 
regular fax cover sheet as it will not be accepted in the faxing system. 

What do I do with the rest of the CANS information if the caregiver or member does not 
consent? 

If the parent or guardian of a minor member (or the member if she or he is 18 or older) declines 
consent, then CANS should be completed on paper and included in the medical record. The CBHI 
system on the VG will not permit entry of CANS rating or narrative fields without consent. 

Please remember that you must still enter SED and demographic information into the CANS 
application on the VG and you must complete a copy of CANS for the medical record regardless of 
member consent. 

Can consent be cancelled? 

Yes, members may cancel consent. The application allows the provider to change the consent status 
of a member at any time. 

Does consent expire? 

Consent will automatically expire after a specified period of time. The default length is one year, 
although the consent form and the application allow the member to specify a shorter or longer period 
of time if preferred. If you anticipate that the member will be in treatment for more than a year, you 
may want to suggest a longer expiration period for the consent.  

What are the additional responsibilities of a provider regarding consent? 

Providers have the independent responsibility to examine and comply with applicable federal and 
state privacy laws, regulations and rules as well as their own privacy policies and practices.  

Who can access information from the online CANS application? 

The VG is designed and extensively tested to be highly secure. The CBHI system does not include 
social security numbers or financial information that is most often the target of hackers. Consent gives 

http://www.mass.gov/masshealth/cans
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MassHealth and the member’s managed care plan access to the member’s information. To protect a 
child’s privacy, MassHealth keeps tight control over who has access to the database. Access to your 
CANS record is restricted and protected under state and federal privacy laws. 

What is the benefit of consenting to entering CANS data in the CANS application online? 

In early 2015, all provider who care for the same child and have active consent from the child’s 
caregiver will be able to view and copy the child’s CANS on the CANS application on the VG. The 
benefits of consent include the ability to view and copy the CANS to share with the family, to easily 
update the CANS without needing to create multiple paper copies, and to share the CANS with other 
levels of care across provider organizations. Also, by sharing the CANS, the family may not have to 
repeat their entire story, over and over again. Another benefit is the ability of the member’s managed 
care entity (MCE) to see CANS in authorizing care—which may save time. Finally, the state uses 
CANS data entered into the application to gather general information about the delivery of CBHI 
services and in general to improve services for all youth and families using MassHealth. 

Where can I get more information about faxing consents? 

For more detailed instructions about faxing consents, please refer to the CBHI CANS Consent 
Information and Faxing Guide. It is available on the CANS (http://www.mass.gov/masshealth/cans) 
Web page of the CBHI Web site along with other CBHI reference materials.  

If you have any questions regarding faxing consents, please contact Virtual Gateway Customer 
Service at 1-800-421-0938 or (TTY) 617-847-6578 for those with partial or total hearing loss). 

Where can I get more information about the CANS application and consent? 

More information about the consent process, including the consent forms and “how-to” Reference 
Guides, may be found at http://www.mass.gov/masshealth/cans. Click on “How to Use the CANS 
Application on the Virtual Gateway”.  

You will also find the CANS Family Guide on the Clinical Guidance section of CANS page of the CBHI 
website. The three-page document that explains the “what” and the “why” of the CANS to family 
members, including consent. We encourage providers to share this with families during the initial 
assessment period. Go to http://www.mass.gov/masshealth/cans and click on “Clinical Guidance on 
the CANS”. 

Other Change to CANS 

1. The Diagnoses module has been renamed as Diagnostic Factors and DCM diagnosis of the 
behavioral health condition is no longer part of the CANS. This change is a better fit for CANS 
as the CANS is not intended to be a diagnostic tool but rather a way to communicate needs and 
strengths, and help inform family-driven, collaborative care planning at the right level of care.   

2. Discontinuation of Axis I and Axis II. 

3. Renaming Axis III, Axis IV and Axis V. 

 Axis III has been renamed as Physical Conditions defined as “Physical conditions which 
play a role in the development, continuance or exacerbation of a behavioral health 
condition.” 

 Axis IV has been renamed as Psychosocial Stressors defined as “Events in a person’s 
life, such as the death of a loved one, starting a new job, college, unemployment or even 
marriage can affect behavioral health condition.” 

 Axis V has been renamed as CGAS (Children’s Global Assessments scale) and 
selecting the “?” will bring up the scale. 

http://www.mass.gov/masshealth/cans
http://www.mass.gov/masshealth/cans
http://www.mass.gov/masshealth/cans
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Logon to Virtual Gateway 

To log on to the Virtual Gateway (VG), go to www.mass.gov/vg and select the link “Logon to Virtual 
Gateway”.  Select the Children’s Behavioral Health Initiative (CBHI) business service to enter 
CANS in the VG. 

Note: See the Login Assistance page at www.mass.gov/eohhs/provider/training-and-edu/vg/login-
help-for-providers-and-state-agency-staff.html for more information on setting up a Virtual Gateway 
(VG) account. 

Viewing CANS Records 

A user with a designated organizational role may view CANS with the login id associated with the 
organization.  Functionality within the CANS system is limited to view-only. Examples of staff in this 
role are Case Manager, Clinic Supervisor, Administrator, etc.  

View and Print a CANS Record (Print-to-Screen)  

Managed Care Entities (MCEs) receive daily CANS data that they can use for daily operations, such 
as authorization and quality management.  

The MCE has a 90-day limitation for viewing CANS tool details.  Reports created within the past 90 
days can be viewed. 

To View a CANS Record 

From the Main Assessment Menu: 

1. Under the View CANS tab, select [View Client] tab. 

2. Enter the [Mass Health ID*]; Select the [OK] button. 

(If this is not the correct MH-client, select the [Cancel] button to enter another member.) 

3. Confirm client information; select the [OK] button. 

The page displays a list of the record(s) for the client (based on your role and organization).  You may 
sort the list by the column headings shown in bold and underlined. Multiple pages may appear with 
arrows at the bottom of the screen for navigation between pages. You also have the option to add a 
new record, if necessary.  

4. To view a specific assessment on the client, select the [View]  button. 

 

Printing a CANS Record 

A CANS record may be printed via the Print-to-Screen (PDF) function under both the View Client and 

http://www.mass.gov/vg
http://www.mass.gov/eohhs/provider/training-and-edu/vg/login-help-for-providers-and-state-agency-staff.html
http://www.mass.gov/eohhs/provider/training-and-edu/vg/login-help-for-providers-and-state-agency-staff.html
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View Certified Assessor tabs.   

1. Select on the PDF icon to have the record displayed in a new screen.  

 

 You may review, print or save the record in Adobe Acrobat Reader.   

o If you do not have Adobe Acrobat Reader currently installed you can download it for free 
at http://get.adobe.com/reader/.   

 In the previous display the Serious Emotional Disturbances (SED) details may appear grayed, in 
the Print-to-Screen the grayed out questions will not be displayed. 

2. When completed, close the browser window (  ) and return to the CBHI application. 

Print Blank Forms  

The provider needs the caregiver’s signature on the Consent form.  If a caregiver declines to give 
consent to enter the CANS into the Virtual Gateway (VG), the provider is not required to notify CBHI 
(MassHealth). However, the SED and Demographic section must be completed online and the CANS 
must be completed on paper and then entered into the member’s medical record. The CANS status in 
VG, in this case, will be ‘Documented on Paper’. 

The consent form explains to the caregiver that by signing the consent form, they are giving 
permission to a provider to enter the CANS on the VG and share the CANS with any other providers 
to whom the caregiver has given consent. 

If a caregiver decides to cancel an active Consent, please email a scanned, signed copy of the written 
cancellation to CBHI at: CANS-CBHIMailbox@state.ma.us.  

The Print Blank Forms tab in the Virtual Gateway will now host the New Consent Forms in English, 
Spanish, Russian, Portuguese, Chinese, Vietnamese, Khmer and Haitian Creole languages. Consent 
forms are available in different languages under the Print Blank forms tab. 

1. From the Main Assessment Menu, select the [Print Blank Form] tab. 

http://get.adobe.com/reader/
mailto:CANS-CBHIMailbox@state.ma.us
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2. Select the option of your choice to print the blank form for the CANS tool documents:  

 PDF (Portable Document Format – Adobe Acrobat)  

 RTF (Rich Text Format) 

Generating and Printing Reports 

A MCE has the option to view and print the Brief CANS Summary Report. 

To Print a Report 

1. From the Reports menu, select the [Brief CANS Summary*] report from the drop down menu.  

2. Select the [OK] button. 

 

3. Enter the [Mass Health ID*]. (This field is 12 characters in length)  

4. Select the [OK] button. 

 

5. The Brief CANS Summary report will be generated in PDF and can be viewed by selecting on the 
PDF icon.  
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6. When completed, close the browser window (  ) and return to the CBHI application. 

Export CANS Files 

Exporting CANS records is a two-step process.  

1. Exporting the layout (column headings)  

2. Exporting the file (data) 

Exporting Layout (Column Headings) 

1. From the CANS Welcome page, select the [Export] tab. 

2. Select the [Export Layout] button. 

3. Select the [OK] button. 

 

The File Download dialog box will appear on screen asking “Do you want to open or save this file?” 

1. Select the [Save] button. 

 

 Remember to rename and save file to the appropriate directory on your computer. This saves 
the column headings for later use. 
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 The default name for the Export Layout is “cansheader.txt” and the file type is Text.   

Export File (Data) 

1. From Export page, select the [Export File] button. 

2. Enter [Export From:] date or Select Calendar ( ) icon to select date. (Format: mm/dd/yyyy) 

3. Enter [Export To:] date or Select Calendar ( ) icon to select date. (Format: mm/dd/yyyy) 

Recommend limiting date range to one (1) week range. 

4. Select the [OK] button. 

 

The File Download dialog box will appear on screen asking “Do you want to open or save this 
file?” 

5. Select the [Save] button. 

 
Things to Remember: 

 Remember to rename and save file to the appropriate directory on your computer. This saves 
the CANS data for later use. 

 The default name for the Export File is “cansdata.txt” and the file type is Text.   

Once both files are saved to your computer, log out of the CANS application. 

Using MS Excel to View Exported Report 

Since the exported file has been saved in txt format, to view it in Excel follow these steps: 

Open MS Excel 

1. Select the [Start] menu (located in lower left of computer monitor). 
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2. Select the [Programs] link. 

3. Select the [Microsoft Office] link. 

4. Select the [Microsoft Office Excel 2003] (or similar version) link. 

 

A. Export File (CANS Data) from within MS Excel 

1. Select the [File] menu. 

2. Select the [Open] link. 

3. Locate the directory (specific drive/folder of the saved file) of the saved file. 

4. Select drop-down arrow next to [Files of type:]; select [All Files]. 

5. Highlight the file to open (example: cansdata). 

6. Select the [Open] button. 

 

7. Select the radio button next to Delimited and select the [Next] button. 
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8. Under the Delimiters section: 

 Uncheck the [Tab] checkbox. 

 Check the [Other] checkbox. 

 Next to the Other checkbox, enter the [Pipe-delimiter] ( | ) symbol located above 
the Enter key on keyboard. 

9. Select the [Next] button.  

 
 

10. Select all of the columns in the Data preview section,  

 Select the first column, then using the bottom scroll bar, scroll to the last “General” 
column which will have the ^ character. 

 Press and hold down the Shift-key and select the last [General] column with the ^ 
character. 

11. From the Column data format,  

 Select the radio button next to [Text]. 

Note: You can easily change number formats later in Excel, if needed. 

12. Select the [Finish] button. 
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The data should appear in columns and rows.  
 

A) Export Layout (Column Headings) from within MS Excel 

1. Select the [File] menu. 

2. Select the [Open] link. 

3. Locate the directory (specific drive/folder) of saved file. 

4. Select drop-down arrow next to [Files of type:]; select [All Files]. 

5. Highlight the file to open (example: cansheader). 

6. Select the [Open] button. 

This will open the Text Import Wizard (3 steps wizard) on the screen. 

1. Select the button next to Delimited and select the [Next] button. 

2. Under the Delimited section: 

 Uncheck the [Tab] checkbox. 

 Check the [Other] checkbox. 

 Next to the Other checkbox, enter the [Pipe-delimiter] ( | ) symbol located above 
the Enter key on keyboard. 

3. Select the [Next] button. 

4. Select all of the columns in the Data preview section,  

 Select the first column, and then using the bottom scroll bar, scroll to the last “General” 
column. 

 Press and hold down the Shift-key and select the last [General] column. 

5. From the Column data format,  

 Select the radio button next to [Text]. 

6. Select the [Finish] button.  

Column headings appear in column format. 
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The Column headings need to be reformatted to appear in Row 1. 

1. Select the first cell (A1); scroll down to the last row (A254) with data.  

2. Press and hold down the Shift-key and select the last row that contains data in Column A. 

3. Right select on highlighted section; select the [Copy] feature. 

4. Select the [Insert] menu. 

5. Select [Worksheet]. 

6. Right select in cell A1, select [Paste Special]. 

7. Check the [Transpose] box. 

8. Select the [OK] button. 

 

The Column headings appear in Row 1. They must be inserted into the report. 

 Right select on Row 1; select the [Copy] feature. 

Return to file with data so that the Column headings can be inserted into the report. 

 Right select on Row 1; select the [Paste] feature. 

Congratulations, you have successfully exported your CANS Report!  

Note: It is recommended that after completing the Text Wizard you save the Exported file: 

 Change name of file 

 Save file as an Excel file 

 Save file to the appropriate directory on your computer  

Reminder: You now have a file containing Protected Health Information on your computer. 
Remember to follow your organization's procedures regarding privacy and data security. 
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Questions or Need Assistance?  

Call Virtual Gateway Customer Service 

1-800-421-0938  

(617-847-6578 - TTY for those with complete or partial loss of hearing) 

8:30 am to 5:00 pm Monday through Friday 

Bookmark the Children's Behavioral Health Initiative Website: 

www.mass.gov/masshealth/cans  
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